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OOTP 9

Welcome to the Out of the Park Baseball 9 online manual!

This web site contains information about OOTP 9, including detailed descriptions of each 
page in the game. The online manual is designed to be read through sequentially, using 
the "Next Page" links at the bottom of each page.

However, feel free to use the menu on the left to browse through the different sections of 
the manual. You can also use the search engine on the top right of this page to look up 
specific keywords in the manual.

OOTP 9's online manual is accessible from inside OOTP 9 as well. When you use the F1 
key in the game to open the in-game help, you will be directed to the appropriate page in 
our online manual.

Here are a few other helpful links: OOTP Message Board | Tech Support Forum | Online 
FAQ 

Introduction and Installation

OOTP?9 is the next in the series of baseball management simulations from Out of the 
Park Developments. No baseball simulation offers you this much flexibility and this 
much fun. Ideal for historical, fictional, and online fans alike. No game does it better!

OOTP lets you do almost anything a real-life general manager can do to guide a team to 
glory. You can create your ideal baseball universe using real world players and teams, or 
fictional ones. Play solo or compete with other human players in online leagues.? 

In OOTP, you control every aspect of your team. Set your pitching rotation. Scour the 
waiver wire for someone to fill out that last roster spot. Trade that aging veteran at the 
deadline for an up-and-coming prospect. Fund your organization's scouting arm to try to 
build?up your minor leagues. It's all there.?



5

System Requirements

System requirements for OOTP Baseball are as follows:

Minimum Recommended

PC

Windows?XP

1 GHz processor

1024 x 768 screen resolution

400 MB free hard disk space

256 MB RAM

Windows Vista or XP

AMD or Intel Dual Core 2GHz

1GB RAM

1024 x 768 32Bit display

1GB HD space

MS compatible mouse & keyboard

Mac

PowerMac:

G4 1 GHz

Mac OS 10.3.9

256 MB RAM

Intel Core Duo:

1.8 Ghz

Mac OS 10.4.4

256 MB RAM

1024 x 768 screen resolution

400 MB free hard disk space

PowerMac/PowerBook:

PowerPC G5 2GHz

Mac OS 10.4.8

1GB RAM

1GB HD space

Mac Pro/MacBook:

Intel Core Duo 2GHz

Mac OS 10.4.8

1GB RAM

1GB HD space

OOTP supports all screen resolutions of 1024 x 768 and higher. Dual monitors are also 
supported.

Important: Your video card must support Open GL in order to use the fictional face 
generation feature, although some older video cards may not be able to handle the 
fictional face generator. Without Open GL support, you can still play Out of the Park 
Baseball, but you will be unable to use the fictional face generator.
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Purchasing the Game

Out of the Park Baseball is available for PC and Mac through digital download only. 
OOTP Developments has partnered with ViaTech Technologies, Inc. to handle the 
licensing of the Windows version of the game through its eLicense system. Licensing for 
the Mac version of the game will be handled by E-Sellerate.

Upon purchase, an 'Order ID' will be generated and displayed on the purchase screen. It 
will also be e-mailed to the purchaser. This 'Order ID' is a string composed of letters and 
numbers. Do NOT lose the Order ID as it is needed to unlock and activate the game 
itself. Also, if you ever need to reinstall the game, such as due to a computer issue or 
moving the game to another computer, this Order ID will be needed again. Don't lose the 
Order ID!

Visit our purchase page for more information on purchasing Out of the Park Baseball.

You can also download the game directly from our download page.

Installing the Game

Well, you've purchased OOTP 9 and downloaded the software - now, how to get started? 
OOTP uses a quick and straightforward installation program on both the Windows and 
Macintosh platforms. There are two steps to get started: install the software, and install 
your license. Follow the instructions here to get OOTP up and running.

Installing OOTP (Windows)

To install the game, follow these steps:

1. Download the game. After this step is completed, you should have a file called 
ootp9setup.exe?saved somewhere on your computer.

2. Double-click the .exe file. The setup program will launch and bring you to the 
Welcome screen. Click the Next button to continue with the installation. You will be 
taken to the License Agreement page.

3. Read the License Agreement. Click the 'I agree' radio button, and then click Next to 
continue. You will be taken to the?Installation Folder page.

4. If you want to use the default destination folder, click Next and skip to Step?6 below. 
If you want to change the destination folder, click the Change button. You will be taken 
to another page.

5. Select the installation directory you wish to use, or use the Make New Folder to create 
a new one, and then click OK. Click Next to proceed.

Note: Normal installations install different files in different areas of your computer. If 
you choose to install in a directory other than the default, all files will be stored in the 
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new directory. See what?gets installed?where for more information.

6.? Choose a shortcut folder ("program group") for the game to use, and whether these 
shortcuts should be available for all users or just the current users.

7. On the "Ready to Install" screen, confirm the settings you have selected, and then click 
Next to begin the installation. During the install process, you will see a progress meter.

8. When the install is complete, you will see a completion message. Click Finish to 
complete the installation. A shortcut to the game will be placed on your Desktop, and in 
the shortcut location you specified, (by default,?Start | All Programs | Out of the Park 
Developments | OOTP Baseball 9).

Installing OOTPB (Mac)

To install the game, follow these steps.

1. Download the game. After this step is completed, you should have a file called 
ootp9macsetup.zip saved somewhere on your computer. Double-click the .zip file to 
unzip it.

2. A new folder will be created called OOTP 9 Install. Open this folder and double-click 
the program called "Mac Installer." A 'splash' page will display. 

3. On the Select options screen, choose where you would like to install the game. If you 
leave the "Use default folders" box checked, OOTP will be installed in your Applications 
folder. Choose whether or not you want a shortcut on your desktop, and then click Install.

4. The game will be installed. This might take a few minutes.

5. When the installation is complete, click on the?Finish button. The game will be placed 
in the destination folder you defined during the installation.

Installing Your License

Okay, the game is installed! All that remains is to prove to the game that you have a valid 
license. 

Note: By purchasing OOTP, you are entitled to install the game on two (2) machines. 
However, you cannot mix licenses between PC and Macintosh. That is, if you want to 
have one copy for a Windows machine and another for a Macintosh, you must purchase 
two copies of the game.

Licensing OOTP (Windows)

Use the following steps to install your license for OOTP, assuming you have already 
purchased a copy of the game:

1. Double-click on the OOTP Baseball 9 icon on your desktop to start the game. You will 
be presented with a licensing page.



8

2. If you have not yet purchased the game, you can purchase the game directly from here 
by clicking on?the Purchase button. You will have several options to purchase the game, 
including through a series of screens on your desktop, through a web site, and by phone. 
Once you have completed your purchase and have received an Order ID, continue with 
these steps to license your game.

3. Once you have an Order ID, click on the License button. You will be taken to the 
Install License page shown below. Enter the Order ID you received into the Order ID box 
and click Install License. You must have an active internet connection to complete this 
step. If you do not have an active internet connection, click the 'Get Off-line License' 
button and follow the instructions on-page to install your license.

4. Once the license has been installed, you will receive a confirmation message. Click the 
Launch! button to start the game. You're ready to play!

Licensing OOTP (Mac)

Use the following steps to install your license for OOTP, assuming you have already 
purchased a copy of the game:

1. Double-click on the?OOTP Baseball 9?icon in the OOTP Baseball 9 folder to launch 
the program.

2. From the main page, if you have not yet purchased the game, you can do so by clicking 
on the "Buy OOTP Baseball" link at the bottom of the page. If you have already 
purchased the game, and know your license key, proceed to Step 3 below.

3. Click on the "Enter a License Key" button at the bottom of the page. A small window 
will appear. 

4. Enter your complete license key into box, or cut-and-paste it from your receipt. Then 
click OK. You will be returned to the main page. The game is now licensed. (You can 
double-check this by viewing the buttons at the bottom of the page. If the button there 
says "unlicense game," then you have successfully licensed the game.)

5. That's it, you're ready to play!

What gets installed where?

OOTP installs a number of files and directories. In the case of Windows machines, these 
files get installed in several different places, thanks largely to Microsoft! Here is a 
breakdown of what gets installed where in a default installation!

Note: Some of this information changes if you chose to install in a directory other than 
the default. See the end of this page for more information!

Program Files

Program files that users cannot modify are all placed in the Program Files directory, by 
default in this directory:
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Uninstalling OOTP (Mac)

To uninstall OOTP 9, simply drag the OOTP 9 folder to the Trash.

Unlicensing the Game

To unlicense OOTP 9 on the Mac use the following steps:

1. Double-click on the OOTP 9 icon to launch the game.

2. On the main page, click on the "Unlicense Game" button at the bottom of the page.

OOTP Interface and Controls

Out of the Park Baseball 9 features a browser-style interface with hyperlinks, right-click 
menus, drag and drop, recent page history, bookmarks, customizable player lists and 
filters, and much more. Not only does the interface look great, it makes your OOTP 
experience comfortable and incredibly flexible.

This section reviews most of the components of the OOTP interface. These are repeated 
throughout the game, so it's good to get an understanding of how they behave. Don't 
forget to check out our description of OOTP's powerful Views and Filters as well.

If you're more of a visual learner, check out our video tutorials. Video tutorials can be 
accessed through the Help menu in the game.

OOTP Controls

OOTP is primarily a mouse-driven game. In other words, if something interests you, click 
on it. The game interface is reminiscent of a web browser, and most users will be familiar 
with the appearance of colored text 'hyperlinks' that appear throughout the game. Click 
on a link to be taken a page with more information about the object you clicked. In-game 
hyperlinks are typically shown as colored text, and will change color in some way when 
you 'mouse over' the text. These links include menus, names, teams, and other 
information.

Right-Clicking

OOTP uses right-clicking extensively. (Macintosh users with a single-button mouse must 
hold down the CTRL key while clicking to use the right-click functionality.) In most 
cases, right-clicking on an object will bring up a menu of actions that we refer to as a 
'right-click menu.' For example, right-clicking on a player name brings up a menu of 
actions that pertain to that player, such as promoting the player or assigning him a spot in 
the lineup. The actions available in the right-click menus are context-sensitive, meaning 
that they might change depending on the page. For example, on the Lineups page, the 
right-click menu includes options for inserting a player into the lineup or removing him 
from the lineup. On the Depth Charts page, the right-click menu includes options for 
inserting a player into the depth chart or removing him from the depth chart.
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Similarly, right-clicking on any of the tabs in the game brings up a right-click menu with 
all the pages and subpages available in that area of the game. (See below for more 
information on the terms 'tab,' 'page,' and 'subpage.')

Right-clicking has one other important function, called quick return. On most pages, 
right-clicking in an area of the page without a hyperlink returns you to the previous page. 
For example, if you delve from the Roster page into a specific Player Profile, right-
clicking on the Player Profile page will send you back to the Roster page.

Drag-and-Drop

Many game pages also support 'drag-and-drop' functionality. For example, you can often 
make changes by dragging players from one area of the page to another. Drag-and-drop is 
used most noticeably in making roster transactions, trading players, and in setting up your 
lineups, pitching rotations, and depth charts. If a page supports drag-and-drop, that fact 
will be noted in the description of that page.

Backspace

In most areas within OOTP, hitting the Backspace key on your keyboard will take you 
back one page, just like the back arrow in a web browser. 

The OOTP Interface

The OOTP interface takes advantage of a number of tools to make it as easy as possible 
for you to get at the wealth of information in the game. Below is a description of the 
interface features used in OOTP. Not all of these will be used on each page in the game. 
The numbers in the following text correspond to the numbered circles in the screen shots.

1. Game Page Navigation Arrows

Game page navigation arrows appear at both the top and bottom of the page. They allow 
you to move back and forth between game pages. The left and right arrows function like 
a web browser's Back and Forward buttons. Click the left arrow to go back to the page 
you visited just before the one you are viewing, and the right arrow to move in the 
opposite direction through pages you have visited recently.

Additionally, the backspace key on your keyboard can also be used to move you back one 
page.
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2. Banner

A banner extends across the top left of most pages in OOTP. The information provided in 
a banner changes depending on the page. In most cases it will tell you the name of the 
page and subpage you are viewing. 

3. Game Menus

OOTP has eight primary game menus that run across the top of the page beneath the 
banner. Unlike many other aspects of OOTP, the content of these menus does not change 
based on where you are in the game. The menus and their options are described in detail 
elsewhere in the online help, hyperlinked below.

Menu Menu Contents

Game
Contains general game options (Load / Save / New), information about 
manager identities, and game setup information for changing the 
configuration of your baseball universe after creation.

Auto-play 
(Baseball 
icon)

Contains options that move the game date forward. See Auto-Play 
(Simulating Games), for more information.

Manager
Contains pages that relate to a manager identity, including the manager's 
home page, manager-specific news and history, available manager jobs, 
and shortlists. There is also an option to explore the game world.

League

Contains pages that relate to the selected league, including the league 
home page, league news, standings, scores and schedules, statistics, 
history, and transactions.

Note: The League menu is not actually called 'League.' The menu will 
display the abbreviation of the selected league. For example, if your 
league is the Pro Baseball League (PBL), then this menu would be called 
'PBL.'

Teams
Contains pages for each team in the league. Each team page then contains 
all the information relevant to that team.

Recent

Contains a list of the fifteen pages you have most recently visited in-game. 
This menu changes dynamically throughout the game. You can clear the 
Recent menu at any time by selecting Clear Recent Pages from the bottom 
of this menu.
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Bookmarks

Contains a list of your bookmarked pages. OOTP supports the creation of 
bookmarks through a menu on the bottom right of the page. Bookmarks work 
much as they do in your web browser (Internet Explorer calls them 
'Favorites'). Once you have created a bookmark, you can come back to the 
Bookmark menu at any time and select that bookmark to jump straight to the 
page.

To bookmark a page, navigate to that page and then select Add Bookmark 
from the Bookmark menu. You will see a second page where you can enter 
your own name for the bookmark. Once the bookmark has been added, click 
on the menu again to see your bookmark in the list. Bookmarks appear in the 
list in the order they were created (not alphabetically), with the oldest 
bookmarks on top. There is no practical limit to the number of bookmarks 
you can add. If you create more bookmarks than can be displayed on the 
page at one time, scroll arrows appear at the top and bottom of the menu 
display to indicate that more choices are available.

When you have added at least one bookmark, you gain access to two new 
menu options-Clear Bookmarks and Edit Bookmarks. Click on Clear 
Bookmarks to erase all your custom bookmarks. Click on Edit Bookmarks to 
go to a page where you can rename or delete your custom bookmarks.

Note: By default, you start with a bookmark for the Manager News page. 
This bookmark cannot be erased or edited.

As you add bookmarks, you will notice that the first nine bookmarks you 
create are assigned to the function keys on your keyboard, F2 through F10. 
(F1 is reserved for the help system.)

?
Contains a list of Help-related options. See In-Game Help for more 
information about the in-game help system.

4. Search

By entering text into the search box and pressing the Enter key, you are able to quickly 
find any player, team personnel member, or team in your baseball universe. The search 
engine is not case-sensitive, and it does not support Boolean commands such as AND, 
OR, or NOT.

Note: Human manager identities cannot be found through the search engine, although 
computer managers can be found.

5. Game Information

The top right of the page contains some general information about the game, including 
the name of your game file, the name of the currently active manager identity, the team 
he or she manages, and the team's current record. The manager's name and the team name 
are hyperlinks. If the manager is also a commissioner, the 'Act As' drop-down is 
displayed here. 
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6. Select League Drop-Down

In OOTP, although you can have multiple leagues, the game generally displays one 
league at a time. In the top right-hand corner of most pages in OOTP is the Select League 
drop-down menu, which shows a list of all the leagues in your universe. To change the 
selected league, select a league from the drop-down. See Game Universe Terminology 
for more information on what defines a league.

7. League Information

Below the Select League drop-down are three rows of information. They include:

a. The current date in the league.
b. The abbreviation of the selected league.
c. The current period of the baseball season; for example, spring training or regular 
season.

Note: The current date is not a 'progress meter.' If you are simulating a month of games, 
for example, this display will not change until all simulating has been completed.

8. Tabs and Pages

Many of the areas in OOTP are so full of information that they have been divided into 
multiple pages through the use of tabs across the top part of the page. Each tab displays a 
page of information. A tab is the navigation tool, and the page is what is displayed. In 
other words, you click on a tab to get to a page. For example, you click on the Lineups 
tab to see the Lineups page.

You can also right-click on a tab to get a right-click menu of all the pages and subpages 
in that area of the game. See Right-Clicking for more information.

9. Subpages

Some pages have so much data that they have been broken down further into subpages, 
which are displayed under the row of tabs. Subpages contain subcategories related to the 
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selected tab. For example, the Front Office page has separate subpages that show team 
finances and possible free agents.

Subpages can also be accessed through the right-click menu that appears when you right-
click on a tab. See Right-Clicking for more information.

10. Drop-Down Menus

Drop-downs menus are an important part of the OOTP interface. Most drop-downs are 
located near the top of the page, underneath a row of tabs. In many cases, especially on 
pages with player data, drop-downs are used to define how you want to view the data on 
the page. Specific drop-downs will be described in greater detail in other areas of the 
guide.

11. Column Headings

Game data, such as player information, is usually displayed in a spreadsheet style, with 
rows and columns. Most columns in OOTP are sortable: Clicking on a column heading 
will sort the data according to that column, alphabetically or numerically. Clicking the 
same heading again will reverse the sort order. A small arrow pointing up or down will 
appear in the column heading when the data is sorted according to that column.

Note: Only one level of sorting is supported. For example, you cannot sort by age, and 
then within each age group have the list sort alphabetically by name.

12. Right-Click Menus

As mentioned in Right-Clicking you can often see a right-click menu when you right-
click on an object on the page. Not all objects support right-click menus. However, most 
hyperlinked names support right-click menus. 

Note: Right-click menus are also available within HTML reports in the game.

13. Breadcrumbs

Just below the drop-down menus is a list of breadcrumbs that describe all selected drop-
down settings. This is a quick way to remind yourself of what data you are currently 
seeing.

14. Action Menus

Action menus are where a lot of the 'good stuff' happens. Action menus are usually 'drop-
up' menus, since the options cascade up from the menu when you click on it. They show 
specific actions that you can take. Action menus are different on almost every page; some 
pages have five or more action menu items, and some have none. Additionally, items on 
action menus might or might not appear, depending on your role and which team you 
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control. A commissioner has access to options that a minor league manager does not, and 
a manager has more options when looking at his own team than when looking at another 
team. The specific actions available on each page will be covered later in the guide.

Many of the items in action menus are also available through right-click menus when you 
right-click on a player or team. See Right-Clicking for more information.

15. Icon Bar

The Icon Bar is a series of icons that run across the bottom of most game screens. The 
icons in the icon bar provide quick access to key areas of the game. Most of these areas 
are also accessible through the menus and tabs in the game. The icons are here simply to 
make your life easier. They also have 'tips' that appear if you hold the mouse over an icon 
for a few seconds.

16. Finish Today Button

The Finish Today button is the second way of advancing time in OOTP, along with the 
Auto-Play Menu described in The Auto-Play Menu. Clicking the Finish Today button 
advances time by one day in all leagues across your baseball universe.

Note: Do not use the Finish Day button if you want to play out a game using the Play-by-
Play engine. See Play-by-Play Mode (Playing out Games), Play-by-Play, for more 
information.

Warning! Be careful with the Finish Day button. You have no chance to confirm after 
you click this button, so make sure you have made all necessary management changes 
before clicking.

See The Finish Today Button for more information on using Auto-Play and the Finish 
Today button.

17. Sliders

A number of pages have sliders-bars that toggle in-game settings. Move a slider by 
clicking and dragging the marker between the arrows to the left or right. Alternatively, 
you can click on the arrow on either side of a slider to move the marker one step in that 
direction. Sliders are primarily used on management strategy pages. As a rule, dragging 
or clicking a slider to the left will decrease the use of an option, and moving it to the right 
will increase the chance of that strategy being used.
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18. Quick-Flicks

When you are looking at an individual player page, the top right corner of the page 
includes two player names and arrows pointing to the left and right. These are called 
'quick-flicks,' and they allow you to quickly move to the previous or next player in the list 
you were viewing. Click on a name to open the selected player's profile. 

The names displayed in the quick-flicks are chosen according to the sort order of the page 
you were previously on. For example, if you were looking at your roster, sorted 
alphabetically, the previous and next players in the quick-flicks would be the previous 
and next players in alphabetical order.

Note: Quick-flicks are not available on all pages.

Views and Filters

Many game pages that include player data also have powerful View and Filter drop-
downs. They are excellent for customizing the game to provide the data you want to see.

Views

The View drop-down is typically the leftmost drop-down on a page. Views essentially 
answer the question 'What data would you like to view?' 
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OOTP provides a number of default views, which quickly display information such as 
Batting Ratings, Pitching Potential, and Financial Info. Each view, when selected, 
changes the columns of data being displayed. The newly selected view is also displayed 
in the breadcrumbs, described in The OOTP Interface.

Views can be customized to display almost any information you want.

Using Views

To use a view, select the desired view from the View drop-down. The columns displayed 
on the page will immediately change. 

Customizing Views

To customize a view, select Customize from the drop-down menu. Doing this brings up a 
separate page in which you can modify the default views. You cannot save changes to 
any of the default views. However, you can create a new view based on a default view, 
and then delete the default view.

There is no 'Create New View' option. New custom views are created based on the 
default views. To create your own custom view, first select one of the default views and 
then select Customize.

Note: For easiest customization, select the view that most closely matches what you 
would like to accomplish, prior to selecting Customize. For example, if you want to 
create a view that shows mainly batting ratings, first select the Batting Ratings default 
view. Doing this will reduce the amount of customization you need to perform.

Next, select Customize from the View drop-down. You will see a page that looks like 
this:

The eight tabs across the top contain many fields to choose from, all selected using check 
boxes. You can also click the Clear button at the bottom to uncheck all boxes on the 
selected tab. There is no option to clear all eight tabs at once, so be sure to check each 
tab. You can select any combination of fields from any combination of tabs. The more 
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fields you select, the more cluttered the display will become, since there is limited space 
on the page to display all that information.

The Repeat Columns option allows you to repeat the selected columns up to eight times. 
If you select two check boxes, those columns will be repeated as many times as can fit 
across the page. Why would you use this? For example, let's say you want to create a 
view that shows just player names. If you do this with the default settings (repeat 
columns once), you get a one-column view of players that continues for many pages. 
However, if you set the columns to repeat five times, your view will contain five 
columns, each containing names. This technique will display five times as many names 
on one page. It's a great option when you are creating views that have only a few pieces 
of information.

Once you have selected the settings you want, click OK to return to the previous page. 
Your new view will be applied automatically to the data on the page. The newly selected 
view is also displayed in the breadcrumbs, described in The OOTP Interface.

Saving Views

Once you have a new or modified view, the Save View option appears in the View drop-
down. Use this option to assign a name to your custom view.

Warning! Don't forget to save your view. It is not saved when you click OK. You must 
use the Save View option if you want to save your view permanently. If you try to switch 
to another view before saving your changes, a warning is displayed.

Modifying the Default Views

You can modify the default views as well. For example, if you like the default Batting 
Ratings view, but you want to add player nationality, do the following:

1. Select the Batting Ratings view.

2. Select the Customize option and add Nationality, then select OK.

3. Select Save View, and enter the exact name of the view you want to replace, in this 
case 'Batting Ratings.'

4. You will be prompted to verify that you want to replace the view. Say 'Yes,' and you 
now have a customized version of the default view.

Editing and Deleting Views

The Edit Views option in the drop-down allows you to rename or delete views.

Filters

The Filter drop-down menu is to the right of the View drop-down menu. The Filter drop-
down answers the question 'Whose data would you like to view?' By default, OOTP 
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displays data for all relevant people for the current page. For example, the draft page 
displays all players in the draft by default.

Unlike with views, the game has no default filters, so if you want to take advantage of 
filters, you have to create your own.

Customizing Filters

Filters are excellent for narrowing lists down to the data you want to see. For example, 
let's say you're looking at the Show All Players page, thinking about prospective trades 
for your organization. You are weak at catcher, and you don't have any good prospects, 
so you want to look for possible players to obtain in a trade. You would prefer someone 
who hits left-handed, has a contact rating of at least 60 (out of 100), and is no older than 
30. A custom filter can do this easily, together with the Position drop-down.

Select Customize from the Filter drop-down, and you arrive at a page much like the 
Customize View page.

If you click on the empty drop-down menu, you will see a long list of characteristics to 
choose from: player demographics, batting, pitching, and fielding skills, and so on. Once 
you select a field, a drop-down menu appears to the right of the characteristic, allowing 
you to specify what you want to look for.

There are numerous numeric criteria such as 'Is Below' and 'Is At Least.' In the case of 
nonnumeric values such as batting handedness, the criteria will change appropriately. 
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You can also click the Clear button at the bottom to reset the page. Clicking on the + sign 
to the right of the criteria will add another criterion. Continue this process until you have 
defined your filter. For our catcher example above, it might look something like this:

Once you have selected all the settings you want, click OK to return to the previous page. 
Your new filter will be applied automatically to the data on the page. Now you see only 
players with a catcher ability of at least 25, with a contact rating of at least 60, who are 
under 31 years of age, and who are either left-handed or switch hitters. To further ensure 
that you are looking only at catchers, you could select Catcher from the Position drop-
down box as well. The newly selected filter is also displayed in the breadcrumbs.

Saving Filters

Once you have a new or modified filter, a new option will appear in the Filter drop-down, 
called Save Filter. Use the Save Filter option to assign a name to your custom filter.

Warning! Don't forget to save your filter. Your filter is not saved when you click OK. You 
must use the Save Filter option if you want to save your filter permanently. If you try to 
switch to another filter before saving your changes, a warning is displayed.

Criteria Check Boxes

Each criterion also has an associated check box to the left. By unchecking these boxes, 
you can quickly remove criteria from your filter without deleting them. This way, you 
can include them again later much more easily.

Filter Templates

The filter page also has a Template drop-down in the upper right that includes a number 
of templates for filters. These can speed up the building of your template. For example, 
there is a template for Starter that immediately selects players whose role is Starter. Try 
checking templates before you build your filter.

Other Filter Options

Within the Player Filter page, there are a number of other options. 

The Show Filter Columns check box, when selected, will automatically add any fields 
you use in a custom filter to your view. For example, let's say your view shows you the 
player's ratings only. Then you create a custom filter using player height and weight. As 
soon as you do this, the height and weight columns will be automatically added to your 
view. 

The Attributes button is another tool to help speed up the creation of a filter. It displays a 
list of attributes with check boxes.
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At the bottom is a drop-down like that on the custom filter page that allows you to set a 
value and an operator. By selecting check boxes and setting an operator and value, you 
can add multiple conditions to a filter at once. For example, if you want your filter to 
exclude any pitchers who have a Stuff, Movement, or Control rating below 10, then you 
can select all three check boxes on the Attribute Filter page. This has the same effect as 
creating three separate conditions, it's just faster.

The Import drop-down contains a list of all custom filters you have created. If you select 
one of your custom filters from this drop-down, the selected filter will be copied into the 
filter that you are currently modifying. This is handy if you want to create a filter that is 
similar to one of your existing filters. Instead of creating the filter from scratch, you can 
import the similar filter, and then modify from there.

Different Types of Views and Filters

There are eight types of filters and views in OOTP. Each type is distinct, meaning that 
you can have entirely different custom views in each area. If you create a custom view on 
the Draft page, that custom view is not available on the Player page. The six types of 
views and filters are described below.

View / Filter Usage

Search Coaches 
views / filters

Used when performing global staff searches from the Manager 
menu, Staff Search & Shortlist option.

Search Players views 
/ filters

Used when performing global player searches from the Manager 
menu, Player Search & Shortlist option.

Draft Players views / 
filters

Used during inaugural or amateur player drafts.
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League Message 
views / filters

Used when selecting a filter on the League News page.

Note: This is not a customizable filter. 

All Messages views / 
filters

Used when selecting a filter on the Manager News page.

Note: This is not a customizable filter. 

All Players views / 
filters

Used on pages with player information, such as lineups, rosters, 
and free agent lists.

All Coaches views / 
filters

Used on pages with personnel information.

Team Players views / 
filters

Used when looking at player information for a specific team, such 
as a specific team's roster or lineups.

Views are stored in a series of files located in the data\tables directory where you 
installed the game. (If you installed in the default location, this would be C:\Documents 
and Settings\<your user name>\My Documents\Out of the Park Developments\OOTP 
Baseball 9\data\tables.)

Using Views and Filters across Multiple Games

One of the most important features of views and filters is that they apply to every OOTP 
saved game on your machine. Playing in two online leagues, plus a solo game? There's 
no need to recreate your views or filters-you can use your views and filters in each of 
your baseball universes.

Note: Even in online leagues, when you download a new copy of a league file, your filters 
and views remain intact.

Common Drop-Downs

In addition to the views and filters described in Views and Filters, OOTP uses a number 
of drop-down menus in the game to help you manage your data. Many of these drop-
downs appear on some pages, but not on others, depending on the context. Here are some 
of the more common drop-downs found in the game and how they are used.

Position Drop-Down

Most pages that show player data include a Position drop-down, usually just to the right 
of the views and filters. Use this drop-down to limit the names displayed to players of a 
certain position. You can also choose to display all pitchers or all batters.
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Note: The Position drop-down filters players according to their rated abilities, not their 
currently assigned positions. So, even if you have a player who is a 3B, he may show up 
when you filter by SS, if he is rated at that position. You can create more complicated 
filters using the filter functionality.

Preferred Occupation Drop-Down

Most pages that show team personnel data include the Preferred Occupation drop-down. 
Each staff member in your baseball universe prefers one of the following six occupations: 
manager, general manager, pitching coach, hitting coach, scout, or team trainer. 

Use this drop-down to limit the staff displayed to those who prefer a certain occupation. 
See Coaches and Personnel for more information.

Scouting Drop-Down

Most pages that show player ratings include a Scouting drop-down. This drop-down 
allows you to select which scout's ratings you want to view. You can also view the 
assessments of the game's OOTPSA (OOTP Scouting Association), which produces its 
own set of ratings.



26

If you have scouting turned off, all ratings shown will be the true player ratings. See 
Scouting for more information.

The Scope Drop-Down

Most pages in the game that include statistical data also include the Scope drop-down. 
This drop-down allows you to define the league level from which you want to see 
statistics. 

In other words, if you want to see players' statistics only from major league play, then 
you can select Major League Level from the drop-down. If you have a player who came 
over to the U.S. after five years in Japan, you can select International Level to view just 
his statistics from the Japanese league. You can choose from any of the available league 
levels. By default, the game displays statistics from the level of the currently selected 
league or team.

League levels are classifications of leagues in OOTP. These are defined during the game 
creation process. See League Overview for more information on league levels.

The Split Drop-Down

Most pages in the game that include statistical data also include the Split drop-down. This 
drop-down gives you access to a huge volume of statistical 'splits.' A split is a set of 
statistics based upon specific criteria. For example, if you want to see your hitter's 
statistics against left-handed pitchers only, that is a split called 'Versus Left.' 
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Note: The Double Split drop-down appears only when you have selected a view that 
includes statistics.

The Open in External Browser Button

Many in-game reports have one common feature: the Open in External Browser button. 
The location of this button sometimes changes, but it always has the same effect. Click 
this button to open the current in-game report using your computer's default web browser. 

Warning! Since the game generates reports dynamically, any hyperlinks on reports 
viewed in an external browser will not work.

Note: When you open an in-game report using an external browser, you can no longer 
use right-click menus to perform transactions. This can be done only from the game's 
internal browser. 

Common Action Menus

As with drop-down menus, a number of action menus or 'drop-up' menus are repeated on 
a number of pages. Many of these action menus appear on some pages, but not on others, 
depending on the context. Here are some of the more common action menus found in the 
game and how they are used.

The Report Action Menu

OOTP has many pages that involve lists of data. For example, a team's roster is nothing 
more than a list of players. The list of free agents is the same. Almost all pages that have 
lists of data like this have a Report action menu at the bottom of the page.

The Report action menu can be used to create an HTML copy of the data on the current 
page. There are two options in each Report action menu.

Option Description

Write 
report to 
disk

Writes an in-game HTML report of the current page to your hard disk, and 
opens the file with your external browser. The file is named using the 
current date and time, and is saved in your game directory, under 
\news\html\temp. So, for example, the file might be called:

\test.lg\news\html\temp\2007-03-21-10-42-54.html.

Open report
Opens an in-game report with data on the current page in the in-game 
browser.
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Warning! In the in-game preferences, there is an option to display lists in pages, or with 
a scroll bar. If your preference is set to use pages, only one page at a time will be visible
or be written to disk. For example, if you are looking at a list of players that spans ten 
pages, this feature will create a report of the selected page only.

The Affiliated Teams Action Menu

The Affiliated Teams action menu gives you quick access to any other teams affiliated 
with the selected organization. For example, in a typical major league-minor league 
structure, this menu will show all the major league and minor league teams in the selected 
team's organization.

Selecting a team from this menu takes you to the Team Home Page described in The 
Team Home Page.

The Import/Export Action Menu

The Import/Export action menu appears whenever you are in an online league. It is used 
by team owners and commissioners to transfer information back and forth. 

Importing and exporting is covered in more detail in Importing Team Files 
(Commissioner).

The Picture Action Menu

The Picture action menu appears any time you are on a player or coach-related page. It 
includes options related to fictional player pictures:




